
# $ K  Software for Agilent Technologies PSA and ESA 
E/L/EMC-series Spectrum Analyzers 
 

Software Overview 

The PSA/ESA E/L/EMC software offers a set of connectivity tools that enable you to quickly and easily move data from 
your PSA/ESA E/L/EMC-series spectrum analyzers to your PC.  Whether you are an experienced programmer or 
would prefer not to program at all, the PSA/ESA E/L/EMC software is designed to give you a high-level of instrument 
control using software applications that you are probably already using on your PC.  

For the Non-Programmer — A Simple Toolbar Add-In for Excel and Word 

The PSA/ESA E/L/EMC software provides an easy-to-use toolbar that enables you to connect to your spectrum 
analyzer from either Microsoft® Excel® or Microsoft® Word®. Once connected, you can perform simple trace data 
capture and instrument display image transfers directly into your spreadsheet or document. You can save the data and 
images in spreadsheets, graphs, or image files for use in all Microsoft® Office® products, including PowerPoint and 
Microsoft Project. This is a real time-saver when creating presentations, staff reports, and regulatory reports. 
In both Word and Excel, the toolbar lets you save settings from the spectrum analyzer. You can then restore those 
settings to the spectrum analyzer. In this way, you can replicate frequently-used measurements and cut down on test 
time. 
The toolbar also lets you set up a series of automatic "snapshots" of your data. When you use the Repeated 
Measurement feature, you can capture data from the spectrum analyzer at intervals of your choice, providing a history 
of measurement data. 
Once installed, the toolbar is automatically loaded and operates just like any other toolbar in these applications.  Use 
the Tools menu to add or remove the toolbar from the application.  The Excel toolbar is shown below, followed by a 
brief description of each toolbar button. 
 

  
 
NOTE:  To get started with the toolbar, you will need to open Excel or Word.  The toolbar will automatically load when 
you open the application. 
 

  About Spectrum Analyzer Toolbar  Returns the software version number and a list of the 
supported spectrum analyzer models. 

 

  Connect to Spectrum Analyzer Configures the I/O connection to the spectrum analyzer. 
 

 Capture/Restore Spectrum Analyzer Settings  Captures the spectrum analyzer settings and stores them with 
the toolbar or to an external file. Restores the saved settings to the spectrum analyzer. Allows you to edit the 
name of saved state files or delete saved state files. 

 

 Get Data  Uploads data from the spectrum analyzer to the active worksheet in Excel. Also allows you to obtain 
repeated measurements.  

 

 Stop Repeated Measurements  Stops gathering repeated measurement data from the spectrum analyzer. 
 

                                                                  
# Software_Overview 
$ Software Overview 
K Software overview;Toolbar:overview;Toolbar buttons;Toolbar: 



 Get Screen Image Gets an image of the spectrum analyzer's display and places it in the active worksheet or 
document.  

 

 Toolbar Help  Provides step-by-step explanations to help you learn to use the toolbar. 
 

For the Programmer — A Powerful Automation Server  

For more sophisticated programming, an ActiveX™ Automation Server is provided with the PSA/ESA E/L/EMC 
software to make it easy to program your spectrum analyzer using common programming environments such as Visual 
Basic®. 
To help you become familiar with the structure and operation of the PSA/ESA Automation Server, we have included a 
help file. To access this help file, navigate to:  

Start | Programs | Agilent IntuiLink | ESA | Agilent IntuiLink ESA  
Automation Help 

 

See Also 
Installation  
Troubleshooting  
 



# $ K   About Spectrum Analyzer Toolbar 

The About dialog box displays the version number of the spectrum analyzer toolbar and lists the supported spectrum 
analyzer models. 
 

  
 

                                                                  
# About_Toolbar 
$ About ESA Spectrum Analyzer Toolbar 
K Version 



# $ K   Connect to Spectrum Analyzer 

The PSA/ESA E/L/EMC software makes it easy to establish an interface connection between your spectrum analyzer 
and your PC.  Whether you are connecting to the spectrum analyzer using an HP-IB (GPIB) port or an RS-232 (COM) 
port, the PSA/ESA E/L/EMC software does the work for you.  Simply select an interface address, press the Identify 
Instrument(s) button and the PSA/ESA E/L/EMC software determines which instruments are connected to your PC.  
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$ Connect to Spectrum Analyzer 
K Interface configuration;GPIB (HP-IB) configuration;RS-232 configuration;Remote interface 
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# $ K    Capture/Restore Spectrum Analyzer Settings 

The PSA/ESA E/L/EMC software gives you the ability to store the current spectrum analyzer settings within the toolbar 
program or to a file on your PC. You can restore settings to the spectrum analyzer from either the PC file or from the 
stored settings within the toolbar program. The spectrum analyzer settings saved to a PC file are stored in a binary 
format (.sta file extension). 
 

  

 

See Also 
Get Screen Image  
 

                                                                  
# Storing_the_instrument_settings 
$ Save / Load Spectrum Analyzer Settings 
K Storing instrument state;Setups;Instrument setups;Saving setups;Restoring setups 



# $ K   Get Data 

One of the most powerful features of the PSA/ESA E/L/EMC software is the ability to capture trace data from the 
spectrum analyzer and place it in an Excel worksheet. The data is placed in rows and columns on the spreadsheet, 
with one column for each trace (Trace 1, Trace 2 or Trace 3) that is active. By default, a graph of the data is also 
created and inserted into your document.  
Click on the link below for an explanation of how the data points are calculated and to see a sample of data captured 
in Excel. 
 

  
 

   Click here to see a sample from Excel and to understand how data points are plotted.  
 

See Also 
Start Repeated Measurements  

 

                                                                  
# Acquiring_waveform_data 
$ Get Waveform Data 
K Waveform data;Graph data 



# $ K   Start Repeated Measurements 

The Excel PSA/ESA E/L/EMC toolbar gives you the ability to capture measurement data from the spectrum analyzer at 
intervals that you specify. You can specify a start time for data capture, and either the intervals or the number of times 
that you want data captured. 
 

  
 

See Also 
Stop Repeated Measurements  
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# $ K   Stop Repeated Measurements 

To stop gathering data, press this button. If this button is unavailable, then there are no repeated measurements being 
taken. 

 

                                                                  
# Stop_Repeated_Measurements 
$ Stop Repeated Measurements 
K Repeated measurements;Stop repeated measurements;Repeated measurements,stopping 



# $ K   Get Screen Image 

For documentation purposes, you may want to capture a "snapshot" of the spectrum analyzer display.  With the 
PSA/ESA E/L/EMC software, it just takes a few seconds to insert the image into your Excel or Word document.  You 
can also save the image directly to a file (.bmp, .gif, .wmf, .jpeg, .emf, and .tif formats). 
 

  
 
 

   Click here to see a sample.  
 
 

                                                                  
# Capturing_an_image 
$ Get Screen Image 
K Waveform image;Bitmap image;Screen capture;Snapshot image;Display image 



# $ K   Toolbar Help 

Like most PC applications, a help system is included with the PSA and E/L/EMC software to assist you with the 
operation of the toolbar.  Click on the help icon to view the help system.  

Note 
In Excel, you must dock the toolbar when displaying the help window. Otherwise, the toolbar may disappear. 

                                                                  
# Need_Help 
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# $ K Installing the PSA/ESA E/L/EMC Software 

You can install the PSA/ESA E/L/EMC software from the CD-ROM included with your spectrum analyzer's interface 
module or you can download the software from the Agilent Web site at www.agilent.com/find/intuilink.  Software 
updates and future releases will also be available from this web site.   
For more information on using the PSA/ESA server with Visual Basic, refer to the help file included with the server. 
You need to have an Agilent or National Instruments GP-IB card installed with drivers unless you will be using the RS-
232 (COM) ports only on your PC. 

See Also 
Minimum System Requirements  
Supported Instruments  
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# $ K Minimum System Requirements 

Operating System 
Windows® 95, Windows® 98, Windows® 2000 or Windows NT® 4.0, Service Pack 4 

Hardware 
Pentium-90, 200 MHz or greater 
32 MB RAM (64 MB recommended) 
20 MB free disk space (40 MB recommended) 
 

Environments Supported 

Applications 
Microsoft Office, Service Release 2 to support: 

Microsoft Excel 97 
Microsoft Word 97  

Microsoft Office 2000 to support: 
Microsoft Excel 2000 
Microsoft Word 2000 

 
Software Development  

Visual Basic 6.0 
HP VEE 5.0 or greater 
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# $ K Supported Instruments 

Spectrum Analyzer Models Supported 
Model E4401B   
Model E4402B   
Model E4403B   
Model E4404B   
Model E4405B   
Model E4407B    
Model E4408B   
Model E4411B   
Model E7401A  
Model E7402A 
Model E7403A 
Model E7404A 
Model E7405A 
Model E4440A 
Model E4443A 
Model E4445A 
Model E4446A 
Model E4448A 

 

                                                                  
# Supported_instruments 
$ Supported Instruments 
K Supported spectrum analyzers;Spectrum analyzers supported 



# $ K Complimentary Start-Up Assistance 

Terms and Conditions 
Agilent Technologies will provide Start-Up Assistance at no charge to resolve questions relating to the installation, 
operation, and use of this software product.  Start-Up Assistance is available to help you install the software on your 
PC, establish communication with a compatible instrument, and answer questions relating to the functionality of the 
software components provided by Agilent Technologies.  Start-Up Assistance does not support requests to modify or 
enhance the functionality of the software.  For services not covered by Start-Up Assistance, you may be referred to 
fee-based services for advanced assistance. 
Agilent Technologies will make reasonable efforts to respond to each customer request for Start-Up Assistance within 
two working days, but is under no obligation to respond within a prescribed time frame.  Requests for Start-Up 
Assistance are handled in the order in which they were received.  Agilent Technologies will make reasonable efforts to 
solve customer problems, but cannot guarantee success. 
Agilent Technologies reserves the right to terminate Start-Up Assistance at any time without notice.  
  

                                                                  
# Technical_Support 
$ Complimentary Start-Up Assistance 
K Terms and conditions 



# $ K Contacting Agilent Technologies for Technical Support 

To find the address and phone number of your nearest support representative, visit the Agilent Web site at 
www.agilent.com/find/assist and follow the links to support. 
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# $ Data Plotted in Excel 

Data gathered from the spectrum analyzer is placed into the worksheet in rows and columns. 
The Frequency column is computed by getting the Start/Stop frequency from the spectrum analyzer and the number of 
points in the trace, then calculating the frequency for each point. Each trace column contains the dBm (milli-dB) from 
the spectrum analyzer. The trace data is transferred from the spectrum analyzer using Integer Numeric Data format 
(the SCPI command is :FORM:TRAC:DATA INT) for high-speed transfer and converted to double-precision numbers 
before putting it into the Excel Trace column. 
Note that in firmware revisions A.04.00 or higher, the number of trace points can be changed for the ESA-E series of 
spectrum analyzers. You can obtain new firmware for your spectrum analyzer from the Agilent Web site at 
www.agilent.com/find/ESA. 
 

  
 
When collecting repeated measurements, each new measurement collection is displayed in a new Excel worksheet. 
The worksheet is named the same as the time of the measurements. There is a limit of 500 worksheets per workbook. 
If the spectrum analyzer is in single sweep mode then, at the time each repeated measurement is initiated, the 
spectrum analyzer will be instructed to make a sweep and return the data. If the spectrum analyzer is in continuous 
sweep mode, it will be instructed to start a new sweep and return the data. 

                                                                  
# Waveform_data_plotted_from_Excel 
$ Waveform data plotted in Excel 



# $ Screen Image Captured from Spectrum Analyzer 

You can insert an image of the spectrum analyzer screen into an Excel worksheet or a Word document. 
 

  
 

                                                                  
# Screen_image_captured_from_spectrum analyzer 
$ Screen image captured from spectrum analyzer 



# $ K > Troubleshooting 

Following are some potential problems that you could encounter when using the PSA/ESA E/L/EMC software. 
Click on an item below for information about that topic. 
Instrument Address is Not Listed  
Can't Connect/Lost Connection to the Spectrum Analyzer  
Problems with Captured Data/Screen Image  
Toolbar Disappeared/Does Not Function  
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# $ K Instrument Address is Not Listed 

If the instrument address that you want to connect to is not listed in the Select Instrument Address list in the 
Connect box, check the following: 

•  Did you choose to connect to a spectrum analyzer on your computer or on a remote computer? Look at the label 
above the Identify Instruments button. It will list either “My Computer” or the name or IP address of a remote host. 
If it does not show the host that you want to connect to, press the Advanced button. Then follow the instructions in 
Connect to a spectrum analyzer on a remote host. 
 

  
 

•  If you are listing addresses for the desired computer (either My Computer or a remote computer), you need to verify 
that the instrument is present at the specified address  on that computer. Use the Configure I/O tool, which is part 
of the Agilent Technologies I_O Libraries, to configure or verify the I/O address. Once you have configured the 
address, close the Connect box, then re-open it and try again. 

•  If you are using both the Agilent (HP) I/O Libraries and the National Instruments (NI) I/O drivers (specifically if you 
are using the Agilent Technologies I/O Libraries for creating a LAN client and the NI drivers for a local NI GPIB card) 
there may be conflicts when trying to identify instruments. Each set of libraries/drivers will assign GPIB addresses 
independently. For example, an Agilent LAN client may be set up on GPIB0 in the Agilent (HP) I/O Libraries, but the 
NI driver has set up the local NI GPIB card as GPIB0.  When the PSA/ESA E/L/EMC software is started and an 
attempt to identify the instrument located at GPIB0 is made, the software will not recognize any instrument.  To 
remedy this situation, manually change the GPIB address(es) in either the Agilent Technologies I/O Libraries or the 
NI driver so that none are the same. 
To do this in the Agilent Technologies I/O Libraries: 
1. Open the Agilent Technologies I/O Libraries Control and choose Run I/O Config (or open the Agilent 

Technologies I_O Libraries menu item from the Start menu and choose I_O Config). 
2. In the I/O Config dialog, highlight the conflicting address in the Configured Interfaces section, then click the 

Edit button. 
3. In the Edit dialog box, find the VISA Interface Name and, using the up/down arrows, change the address 

number for the interface. 
4. After a satisfactory number has been chosen, click OK to close the Edit dialog. You should see the new GPIB 

address in the Configured Interfaces section. If not, return to step 2 and chose another setting. 
5. Click OK to close the I/O Config dialog. 

The PSA/ESA E/L/EMC software should now be able to correctly identify the instrument connected at the non-
conflicting GPIB address. 
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# $ K Can't Connect/Lost Connection to the Spectrum Analyzer 

There are three categories of problems relating to connections to the spectrum analyzer. Click on the topic below that 
most closely resembles the problem you are experiencing. 
 
Connection problems to a local instrument  
Connection problems to a remote instrument  
Connection was dropped  
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$ Can't Connect to the Spectrum Analyzer 
K Can't Connect to the Spectrum Analyzer;Troubleshooting:can't connect to the spectrum 
analyzer 



# $ K Connection Problems to a Local Instrument 

If you are having problems connecting to a spectrum analyzer connected to your computer, check the following: 
 

•  All the instruments present at the selected address are listed in the Identified Instruments list. Be sure you select 
an instrument labeled Spectrum Analyzer before you press the Connect button. 

•  Are the cable connections to the spectrum analyzer secure? 

•  Is the spectrum analyzer turned on and functioning? 

•  Is the spectrum analyzer a supported model? Click here for a list of supported spectrum analyzers. 

•  Did you follow the instructions exactly in Connect to the spectrum analyzer and verify communication? 

•  Is another device using the COM port that you are trying to use? 

•  If you are connecting via a COM port, do you have the baud settings for the port the same as those set on the 
spectrum analyzer? Verify these settings and reconfigure the baud rate in the software (double-click on the COM 
port address to get the configuration dialog box). 

•  Are you trying to connect to a PSA-model spectrum analyzer? The PSA models do not support connection via a 
COM port. 

Note: 
After you change the baud rate in the PSA/ESA software to match the baud rate at the instrument, you need to 
power cycle the instrument before trying the connection again. 
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# $ K Connection Problems to a Remote Instrument 

If you are trying to connect to an instrument on a remote host, check the following in addition to Connection Problems 
to a Local Instrument: 
 

•  Do you have communication with the remote host? Try PINGing the remote host and see if you get a response. 

•  Do you have permission to connect to the remote host? If you are not sure or need to be given permission, see your 
system administrator. 

•  Is the PSA/ESA software installed on the remote host? It must be installed to connect via the software. 

•  Is another instance of the PSA/ESA software already connected to the address on the remote host? 

•  If you entered a name in the Remote Host field in the Advanced dialog box, try entering the IP address instead. 

•  Is there a problem with the LAN or any of its switches? Contact your network administrator to find out. 

•  If the remote host uses DCOM, see the section Enabling DCOM Server Interface in Windows NT 4.0 and Windows 
2000. 
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# $ K Connection was Dropped 

If you have lost the connection to the spectrum analyzer: 

•  Microsoft Windows 95 systems and other systems with power management features may encounter problems when 
an instrument is connected and the computer switches to the power-save mode. When the computer is re-activated, 
the instrument connection may be lost or corrupted, resulting in a loss of the PSA/ESA toolbar functionality. In this 
case, you must close the Excel worksheet or the Word document, restart the application, and reconnect to the 
instrument using the toolbar. To avoid this problem, turn off the power management features when using the 
PSA/ESA toolbar. 
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# $ K Problems with Captured Data/Screen Image 

Data is Not What You Expected 

If the measurement data that you captured from the spectrum analyzer is not what you expected, check the following: 

•  Are the settings on the instrument control panel set to capture the kind of data that you want? Reset the display on 
the spectrum analyzer and try again. 

•  Are you connected to the spectrum analyzer from which you want to collect data? To verify, press the Connect icon 
on the toolbar. In the Connect dialog box, look in the Identified Instruments list for the spectrum analyzer with the 
Connect icon next to it. 

 

Screen Image is Not What You Expected 

If the screen image that you captured from the spectrum analyzer is not what you expected, check the following: 

•  Are the settings on the instrument control panel set to display the kind of data that you want? Reset the spectrum 
analyzer and try again. 

•  Are you connected to the spectrum analyzer from which you want to collect data? To verify, press the Connect icon 
on the toolbar. In the Connect dialog box, look in the Identified Instruments list for the spectrum analyzer with the 
Connect icon next to it. 

 

Can’t Capture Images 

If you are having trouble getting the image of your spectrum analyzer and receive an error message similar to 
“Premature end of data for IEEE 488.2 binary block” it might be a problem with your PC configuration. Check the 
following: 

•  Are you using Windows 95 or Windows 98 on a CPU that is 300 MHz or slower? 

•  Are you are using an RS-232 connection? 

•  Is the serial port on the spectrum analyzer’s serial port set to 115,200 baud? 
If all of the above are true, try the following: 

•  Change the RS-232 baud rate to 57,600 or 38,400. 
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screen image 



# $ K Toolbar Disappeared or Does Not Function 

Following are some reasons that the toolbar might disappear or not function as expected. 

•  If you do not have the PSA/ESA toolbar docked while working in Excel, and you open the online help, the toolbar 
may disappear. This behavior is particular to Excel. You should dock the toolbar if you want it to be visible while 
using the online help. 

•  If you clicked the X in the upper right corner of the toolbar, the toolbar will close in the same way that a dialog box 
will close. To re-open the toolbar, go to the View menu in the application, select Toolbars, and put a checkmark 
next to the PSA/ESA toolbar. 

•  You might have unloaded the toolbar for this instance of your application. If so, go to the Tools menu, select Add-
Ins (Excel) or Templates and Add-Ins (Word) and place a checkmark next to the PSA/ESA item. 

•  In Excel, when you double-click in a cell for editing, or when your cursor is in the formula bar, the PSA/ESA toolbar 
and the Excel Tools menu are disabled. This behavior is particular to Excel and occurs with different Add-in 
products. There is no work-around to this problem. 

•  Microsoft Windows 95 systems, and other systems with power management features, may encounter problems 
when an instrument is connected and the computer switches to the power-save mode. When the computer is re-
activated, the instrument connection may be lost or corrupted, resulting in a loss of the PSA/ESA toolbar 
functionality. In this case, you must close the Excel worksheet or the Word document, restart the application, and 
reconnect to the instrument using the toolbar. To avoid this problem, turn off the power management features when 
using the PSA/ESA toolbar. 
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# $ K Enabling DCOM Server Interface in Windows NT 4.0 and Windows 2000 

The PSA/ESA-E/L/EMC software is designed to provide easy access to the instrument through a layered design. 
Included in this design is the use of Component Object Model (COM) interfaces between layers. Some of these 
interfaces can be made accessible from a remote machine via Distributed COM (DCOM). DCOM is a technology that 
is supported on all Windows platforms beginning with the service releases of Windows 95. Full implementation of 
DCOM is really only available on the Windows NT and Windows 2000 platforms due to the lack of security features in 
Windows 95/98. Because of this, the server portion of the PSA/ESA-E/L/EMC software can only provide remote 
access when running on the Windows NT/2000 platforms, while the client portion can be run on Windows 95, 98, NT 
4.0, and 2000.  
Each LAN is unique and has unique security requirements, thus you must determine and perform the security 
configuration of the DCOM interface used by the server portion of the PSA/ESA-E/L/EMC software. Administrative 
privileges are required to perform these steps. Contact your system  or network administrator before making any 
changes. The following steps are provided as a guideline for doing the configuration: 

1. Launch DCOMCnfg by using Start|Run. In the Open: box, type DCOMCnfg and click OK. 

2. In the Distributed COM Configuration Properties (DCOMCnfg) dialog box, select the Agilent IO Manager and 
click Properties. 

3. Select the Security tab and select the Use custom access permissions radio button 

4. Click Edit.  

5. Click Add to add a user or group of users to whom you will grant access to the I/O configuration on that 
machine. You can also select individuals or groups of users to deny access to. Make sure that you have an 
entry for the “SYSTEM” user. Add it if necessary. 

6. Click OK when all of the user permissions for access have been configured. 

7. Select the Use custom launch permissions radio button, and then click Edit.  

8. Select the users to whom you would like to grant or deny the ability to launch the I/O Manager server. Typically 
you should allow at least the people that have access permissions. Do not remove launch permissions for 
“INTERACTIVE”, “SYSTEM”, or “<hostname>\Administrators”.  

9. Click OK when finished to return to the Agilent IO Manager Properties dialog box.  

10. Click OK to return to the Distributed COM Configuration Properties dialog box.  

11. If you will be programming applications that use the Agilent ESA EZ COM interface, repeat the steps above for 
the Agilent ESA EZ listed in the DCOMCnfg dialog box. 

Connecting to Remote DCOM Servers 

To connect the PSA/ESA-E/L/EMC software add-in to a remote server you must specify which server to use. The 
following are the necessary steps to establish the connection: 

1. Make sure that the server has been configured using the guidelines described above. 

2. On the client machine, start Microsoft Word or Excel, and click Connect on the PSA/ESA Spectrum Analyzer 
toolbar. 

3. In the Connect dialog box, click Advanced. The Advanced dialog box appears 

4. In the Hosts field, type in the name or IP address of the remote server. 

5. Click OK to return to the Connect dialog box. The list of instruments available for connection will now be the 
instruments connected to the remote server. You may select any of these for identification and, if appropriate, 
connection. 

Note: 
Only the Agilent IO Manager DCOM interface configuration is required to enable the Microsoft Word and Excel toolbar 
add-ins to access remote servers. 
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$ Enabling DCOM Server Interface in Windows NT 4.0 and Windows 2000 
K DCOM:enable;Enabling DCOM;DCOM 
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